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 شود؟ای استفاده میبرای حذف محتویات یک سلول از چه گزینه .1

  Delete گزینه Home سربرگ -الف 

 Contents Clear گزینه Home سربرگ -ب ️✔

 Clear گزینه Data سربرگ -ج 

 Format Clear گزینه Clear گروه Home سربرگ -د 

 کنیم؟ای استفاده میبرای اضافه کردن توضیحات به یک سلول از چه گزینه .2

 Home از سربرگ Edit گزینه -الف 

 ️✔ Review از سربرگ Comment new گزینه -ب 

 View از سربرگ Comment Insert گزینه -ج 

 Insert از سربرگ Comment گزینه -د 

 کنیم؟ای استفاده میبرای ضبط یک ماکرو از چه گزینه .3

 macro گزینه Insert سربرگ -الف 

 Macro View گزینه View سربرگ -ب 

 ️✔ Macro Record گزینه Macro گروه View سربرگ -ج 

 Macro Record گزینه Macro گروه Insert سربرگ -د 

 .گیرندکلیدهای ......... مورد استفاده قرار می redo برای اجرای سریع فرمان .4

 ctrl +z - الف

 ️✔ ctrl +y - ب

 ctrl +v - ج

 ctrl +x - د

را  template excel کافی است در لیست ....... گزینه template برای ذخیره کردن یک الگو به عنوان یک .5

 .انتخاب کنید

 save in - الف

 ️✔ save as type - ب

 save as name - ج

 file name - د

 . ...... )بر اساس حروف الفبا( برای مرتب کردن اطلاعات موجود در لیست .6

 ️✔ data \ sort - الف

 data \ filter - ب

 insert \ sort - ج

 home \ find - د

 علامت مساوی در شروع یک خانه نشانه چیست؟ .7

 ️✔ شروع یک فرمول -الف 

 شروع یک جستجو -ب 

 filtering شروع عملیات -ج 

 شروع ذخیره سازی یک فایل -د 

 تواند بر اساس شرط تعیین شده، محتوی خاصی را در چند سلول شمارش کند؟یر میکدامیک از توابع ز .8

 if - الف

 - count if ️✔ ب

 sum if  -ج 

   count د

 برای بدست آوردن جمع محتویات دو سلول اکسل کدام فرمول صحیح است؟ .9

 ️✔ A1+B5 = - الف

 A1+b5 = X - ب
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  A1  +   -5ج

    -A1+b5=x د

 در صفحه کاری چه نام دارد؟ها هر یک از خانه .10

 sheet - الف

 ️✔ cell - ب

 - Work book - ج

 file - د

 ها کدام است؟ترین الویت در خواندن فرمولبالا .11

 توان -الف 

 ️✔ پرانتز -ب 

 ضرب -ج 

 تقسیم -د 

 شود؟ای استفاده میبرای حذف یک سطر در اکسل از چه گزینه .12

 ️✔ Rows sheet Delete گزینه Home سربرگ –الف 

 Rows Clear گزینه Home سربرگ -ب 

 columns Delete گزینه Data سربرگ -ج 

 Format Clear گزینه Clear گروه Home سربرگ -د 

 .گزینه ............... را انتخاب کنید type as save برای ذخیره کردن یک الگو در اکسل کافی است در لیست .13

 save in - الف

 ️✔ excel template - ب

 xml data - ج

 file name - د

 شود؟برای فیلتر کردن اطلاعات موجود در لیست از کدام گزینه استفاده می .14

 data \ sort - الف

 ️✔ data \ filter - ب

 insert \ sort - ج

 home \ find - د

 کدام علامت در ابتدای یک خانه نشانه فرمول است؟ .15

 ️✔ = - الف

 $ - ب

 ؟ -ج 

 : - د

 باشد؟های صفحه گسترده نمیهای برنامهکدامیک از موارد زیر از توانایی .16

 ️✔ تولید یک برنامه اجرایی مستقل کامپیوتری -الف 

 حسابداری یک شرکت بازرگانی -ب 

 های تجاریمدیریت اطلاعات و داده -ج 

 بررسی میزان فروش یک شرکت -د 

 .گویندبه هر سطر از جدول داخل کاربرگ ....... می .17

 Cell - الف

 table - ب

 ️✔ row - ج

 Column - د

 .فشاریمرا می Delete برای حذف نمودار روی ...... کلیک کرده، کلید .18

 عنوان نمودار -الف 

 محور نمودار -ب 
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 ️✔ کل نمودار -ج 

 راهنمای نمودار -د 

 .کندفرمان ...... کاربرگ فعال را حذف می .19

 Rename - الف

 ️✔ Delete - ب

 Tabcolor - ج

 Insert - د

 های اکسل چیست؟نام پیش فرض فایل .20

 1Document -الف 

 ️✔ 1Book -ب 

 presentation - ج

 Database - د

 چه کاربردی دارد؟ Number ایدر کادر محاوره places Decimal گزینه .21

 نمایش اعداد منفی -الف 

  جدا کردن ارقام اعداد به صورت سه تایی -ب 

 قام اعشارتعداد ار -ج ️✔

 تعیین نوع عدد -د 

22. type Chart در نمودارها چه کاربردی دارد؟ 

 تعیین عنوان نمودار -الف 

 تعیین راهنمای نمودار -ب 

  نمایش خطوط راهنما -ج 

 تغییر نوع نمودار -د ️✔

 آید؟های زیر به حساب میبرنامه اکسل جزو کدام یک از برنامه .23

 ️✔ صفحه گسترده -الف 

 عاتیبانک اطلا -ب 

 نویسیزبان برنامه -ج 

 واژه پرداز -د 

 نرم افزار اکسل در کدام مورد کاربرد دارد؟ .24

 در امور پزشکی -الف 

  های اطلاعاتیکارهای مربوط به امور بانک -ب 

 کارهای مربوط به ویراستارها -ج 

 امور حسابداری و مالی -د ️✔

 آدرس خانه فعال در کجا فایل رویت است؟ .25

  فرمولدر نوار  –الف 

 در داخل ریبون –ب 

 box name در کادر -ج ️✔

 در سطر وضیعت -د 

 کنیم؟برای مرتب کردن محتوای یک ستون از چه گزینه استفاده می .26

 ️✔ Sort & Filter گزینه Editing گروه Home سربرگ -الف 

 Fill گزینه Editing گروه Home سربرگ -ب 

 Sort گزینه Editing گروه Insert سربرگ -ج 

 Editing گروه layout Page سربرگ -د 
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 توان وارد نمود؟در یک خانه چه نوع اطلاعاتی نمی .27

 متنی -الف 

 تاریخ و زمان -ب 

 عددی -ج 

 ️✔ تصویر -د 

 ترین اولویت است؟کدام عملگر دارای پایین .28

 جمع -الف ️✔

 ضرب -ب 

 توان -ج 

  پرانتز -د 

 بعد کدام است؟به  2007های های اکسل در نسخهپسوند فایل .29

 xelx - الف

 xplx - ب

 xldx - ج

 ️✔ xlsx - د

 شود؟ها از کدام گزینه استفاده میجهت ادغام سلول .30

home- alignment- merge cells - ✔️ 

home- alignment- unmerge cells - 

home- alignment- split table - 

home - alignment- split cells - 

 شود؟از کدام کلیدهای میانبر زیر استفاده می paste و cut برای اجرای فرمان .31

ctrl+y - ctrl+z - 

ctrl+z - ctrl+y - 

ctrl+v - ctrl+x -✔️ 

ctrl+c - ctrl+v -  

امکان اضافه کردن %  format cells از کادر محاوره number های موجود در زبانهکدام یک از گزینه .32

 دهد؟)درصد( را به اعداد می

 currency - الف

 ️✔ percentage - ب

 special - ج

 number - د

 رود؟کدام تابع زیر برای محاسبه میانگین بکار می .33

 SUM - الف

 MAX - ب

 ️✔ AVERAGE - ج

 IF - د

 کنیم؟های موجود در کار پوشه را تغییر دهیم از چه دستوری استفاده میچنانچه بخواهیم نام یکی از کاربرگ .34

 Insert - الف

 Copy - ب

 ️✔ Rename - ج

 Delete - د

 تر است؟چنانچه بخواهیم قالب متن درون خانه را کپی کنیم کدام مناسب .35

Format Painter - ✔️ 

 Cut - ب
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 Copy - ج

 Copy و Cut - د

 شود؟از کدام کلید استفاده می Excel برای انتخاب چند سطر غیر همجوار در .36

 shift - الف

 alt - ب

 ️✔ ctrl - ج

 space - د

 شود؟نگه داشتن تیتر جداول از کدام دستور استفاده می برای ثابت .37

 arrange - الف

 split - ب

 ️✔ freeze - ج

 unfreeze - د

 شود؟بندی شرطی استفاده میکدام گزینه برای قالب .38

Conditional Formatting - ✔️ 

Format Cells - 

 Format - ج

Format as table - 

 شود؟از کدام کلید استفاده می Excel برای انتخاب چند سطر همجوار در .39

 ️✔ shift - الف

 alt - ب

 ctrl - ج

 space - د

 کنیم؟برای تعیین تعداد ارقام اعشاری از کدام گزینه استفاده می .40

 Insert - الف

 Edit - ب

Home- number - ✔️ 

 Format - د

 اب کرد؟کدام گزینه را باید انتخ Print ایبرای چاپ صفحه کاری جاری از کادر محاوره .41

Selection Print - 

Entire Work Book Print - 

print Active Sheet -✔️ 

Print Current Sheet -  

 چیست؟ Round(435.23;1) = نتیجه تابع .42

  435 -الف 

 435.231 -ب 

 435.2 -ج ️✔

 435.23 -د 

 ای استفاده کنیم؟برای ادغام سبک تعریف شده از چه گزینه .43

- Modify 

table style -  

Merge style -✔️ 

- add 

 برای اینکه نمودار در همان صفحه قرار گیرد در کدام مورد باید تعیین شود؟ .44

As New Sheet - 

object in - ✔️ 
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As New Work Book - 

File - New - 

 گیرند؟به چه منظور مورد استفاده قرار می Paste و Copy فرامین .45

 حذف اطلاعات -الف 

 ️✔ کپی اطلاعات -ب 

 جایی اطلاعاتابهج -ج 

 حذف آخرین فرمان و برگرداندن دوباره -د 

 شود؟برای ایجاد یک سبک جدید کدام گزینه استفاده می Home از سربرگ Style Cell از کشوی .46

  .کنیمکلیک می Add بعد از تعیین نام سبک، بر روی دکمه -الف 

 .کنیمرا تعیین میکلیک کرده و سپس نام سبک  style cell new بر روی گزینه -ب ️✔

 .کنیمکلیک می new بر روی دکمه -ج 

 .کنیمکلیک می Ok بعد از تعیین نام سبک، بر روی دکمه -د 

 شود؟برای مرتب کردن یک لیست از کدام گزینه استفاده می .47

  Data از تب Autofilter گزینه –الف 

 .کنیمانتخاب می Data را از تب Form گزینه -ب 

 .کنیمانتخاب می Data را از تب Arrange گزینه -ج 

 .کنیمانتخاب می Data را از تب Sort گزینه -د ️✔

 هاست؟زیر مجموعه کدام یک از انواع برنامه Excel برنامه .48

 واژه پردازها -الف 

 های ترسیمیبرنامه -ب 

 های اطلاعاتیبانک -ج 

 ️✔ های صفحه گستردهبرنامه -د 

 کدام سلول به طور پیش فرض فعال خواهد شد؟ Enter و فشار کلید 1B پس از ورود داده در سلول .49

 1Aسلول  -الف 

 1Cسلول  -ب 

  2Bسلول  -ج ️✔

 2Aسلول  -د 

 شود؟موجب پر شدن یک سلول با خطوط هاشور می Cell Format کدام گزینه از کادر .50

 Gridlines - الف

 Customize - ب

 Texture - ج

 ️✔ Pattern - د

 دهد؟چه کاری را انجام می Delete از پنجره row entire گزینه .51

 .کندسلول انتخاب شده را پاک می -الف 

 .کندفقط محتویات سلول را پاک می -ب 

 ️✔ .کندیک سطر را به طور کامل پاک می -ج 

 .کندیک ستون را به طور کامل پاک می -د 

 مورد درست است؟ در سلول فعال کدام 3Cتا  2Bهای برای جمع کردن محتوای سلول .52

B2+C3 - 

=B2+C3 -  

B2+C2+B3+C3 - 

=B2+C2+B3+C3 -✔️ 

 باشد؟نمی Excel کدام گزینه از کاربردهای .53

 انجام امور نشر رومیزی -الف ️✔

 تهیه دفاتر حسابداری -ب 
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 تهیه نمودار گرافیکی -ج 

  فاکتور فروش -د 

 شود؟ده میبه منظور درج )اضافه کردن( کاربرگ از کدام گزینه زیر استفا .54

Insert Column - 

Insert Sheet - ✔️ 

Insert Row - 

Insert Delete - 

 چیست؟ Labels Data در ترسیم نمودار مفهوم گزینه .55

 ️✔ هانمایش مقدار داده -الف 

 ها در نمودارنمایش جدول داده -ب 

 نمایش شرح نمودار -ج 

 عنوان نمودار و محورها -د 

 ؟ای داردچه وظیفه Count تابع .56

 های انتخاب شدهشمارش سلول -الف 

 های تایپ شدهشمارش سلول -ب 

 ️✔ های عددیشمارش سلول -ج 

 های حاوی متنشمارش سلول -د 

 شود؟های زیر به عنوان متن در نظر گرفته میکدام یک از گزینه .57

 4.3 -الف 

 =2+3 -ب 

 3+2 -ج ️✔

  10:30 -د 

 شود؟زینه استفاده میبرای ترسیم نمودار در یک صفحه جدید کدام گ .58

 Type Chart انتخاب گزینه -الف 

 ️✔ Sheet New As انتخاب گزینه -ب 

 Chart Place انتخاب گزینه -ج 

 Object As In انتخاب گزینه -د 

 ؟ معادل کدامیک از گزینه های زیر است   =Sum(A1:A10)/10فرمول  .59

 Round(A1,A10)   =-الف

 Averege(A1:A10)   =-ب

 =Subtotals(A1:A10) -ج

 Count(A1:A10)=   -د

 کنیم؟ها از کدام گزینه استفاده میهای تکراری در سلولجهت تسریع عمل پر کردن داده .60

Auto Correct - 

Auto Format - 

Auto Stayl - 

Auto Fill - ✔️ 

 sum(A2:C5;D8)=وظیفه دستور  .61

  8Dو سلول  5Cتا  2Aهای محاسبه مجموع سلول -الف ️✔

 8Dو سلول  5Cبا  2Aهای محاسبه مجموع سلول -ب 

 8Dتا  5Cهای و سلول 2Aمحاسبه مجموع سلول  -ج 

 8Dتا  2Aمحاسبه مجموع سلول  -د 

 کدام گزینه صحیح است؟ .62

A1=A2+A3 - 

=A2+A3 - ✔️ 
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A2+A3= - 

A2=A3 - 

 توان استفاده کرد؟برای ویرایش خانه فعال از کدام کلید می .63

 3F -الف 

 1F -ب 

 2F -ج ️✔

  4F -د 

 . ............ توانبرای انتخاب یک محدوده مشخص می .64

 .را زد Ctrl خانه اول را انتخاب و سپس -الف 

 .گیریمرا می Alt انتخاب اولین خانه -ب 

 ️✔ .کنیمرا گرفته و خانه انتهایی را کلیک می Shift کنیم و سپسخانه اول را انتخاب می -ج 

 هانهکلید جهتی و انتخاب خا -د 

 ها انجام داد؟ها را در خانهترازی دادهتوان هممی Cells Format با استفاده از کدام تب از .65

 Number - الف

 Font - ب

 ️✔ Alignment - ج

 Border - د

 دهد؟چه عملی انجام می Fit To Shrink گزینه Alignment از تب Cell Format در کادر .66

 ️✔ .شود تا در طول خانه جای گیردغییر مقیاس داده میمتن نوشته شده در خانه طوری ت -الف 

 ها در یک خانهترکیب محتوای خانه -ب 

 .گیرداگر طول متن از خانه بیشتر باشد بقیه متن در خط بعد قرار می -ج 

 .کندکشیده شدن متن تا عرض خانه را پر می -د 

 . ........... تکراری از گزینه برای بالا بردن سرعت انجام کارها و جلوگیری از انجام کارهای .67

 Merge - الف

  Template - ب

 Style - ج

 Style و Template - د️✔

 رود؟به چه منظور بکار می Review از تب Sheet Protect گزینه .68

 یابی خودکارغلط -الف 

 ️✔ رمزگذاری روی صفحه جاری -ب 

 Book Work رمزگذاری روی -ج 

 کاربربه اشتراک گذاشتن اطلاعات  -د 

 برای تغییر زاویه مشاهده نمودار سه بعدی کدام گزینه صحیح است؟ .69

 Type Chart گزینه Chart از تب -الف 

 Option Chart گزینه Chart از تب -ب 

 view -d3 گزینه Chart از تب -ج ️✔

  Location گزینه Chart از تب -د 

 =max(A1,B1,F3)    م است؟ باشد حاصل تابع زیر کدا F 3=4و  1A = True, 1Aو1B =KH اگر .70

 4Khtrue -الف 

 صفر -ب 

 Error - ج

 ️✔ 4 -د 

 تواند کار چند تابع را انجام دهد؟کدام دستور می .71

 Sum - الف

 ️✔ Subtotals - ب
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 Average - ج

 Form - د

 کدام مورد را باید انتخاب کرد؟ Print ایبرای چاپ کل سند از کادر محاوره .72

Active SheetS - 

Entire Work Book - ✔️ 

 Selection - ج

 List - د

باشد تابع روبرو چه عددی را  -8 -14 -16 -10 -18 24به ترتیب از بالا به پایین اعداد  d6  ات1dاگر مقادیر  .73

   max(d1:d5)= گرداند؟برمی

 24 -الف 

 8 -ب 

 16 -ج 

 ️✔ 18 -د 

 کدام مورد زیر صحیح نیست؟ .74

 .ای که بتوان در آن داده وارد کردصفحهکاربرگ یعنی هر  -الف 

 .دهدتقاطع هر سطر و ستون یک صفحه کاری را تشکیل می -ب ️✔

  .های مجاور هم را بطور افقی سطر نامندسلول -ج 

 .توان عددی، متنی، تاریخ، زمان نام بردانواع مقادیر داخلی سلول را می -د 

 ی کدام مورد صحیح نیست؟در مورد ذخیره کردن اطلاعات در داخل صفحه کار .75

 .شودهر صفحه کاری در یک فایل ذخیره می -الف ️✔

 .است xlsx های صفحه گستردهپسوند فایل -ب 

 .استفاده کرد As Save یا Save توان از گزینهسازی میبرای ذخیره -ج 

  .از نوار ابزار دسترسی سریع است Save سازی کلیک دکمههای ذخیرهیکی از روش -د 

 دهد؟چه عملی انجام می Down Cells Shift ام اضافه کردن یک سلول گزینههنگ .76

 ها به راستانتقال سایر خانه -الف 

 ها به چپانتقال سایر خانه -ب 

 ✅ ها به پایینانتقال سایر خانه -ج 

 ها به بالاانتقال سایر خانه -د 

 ...توانمی Alignment ها با گزینهدر هنگام قالب بندی سلول .77

  شکل نمایش متن را تغییر داد -الف 

 رنگ پشت زمینه را تغییر داد -ب 

 قالب بندی حروف را تغییر داد -ج 

 ترازبندی متن را تنظیم کرد -د ✅

 چیست؟ Text Wrap مفهوم گزینه .78

 ✅ .متن طولانی بصورت چند سطری نشان داده شود -الف 

 .های انتخاب شده با هم به یک سلول تبدیل شوندسلول -ب 

 .های انتخاب شده به چند سلول تقسیم شوندسلول -ج 

 .متن کوچک و ریز شده تا در سلول جا بگیرد -د 

 شود؟ها از کدام گزینه استفاده میبرای تغییر رنگ زمینه سلول .79

 ✅ fill color - الف

 Border - ب

 Protection - ج

 Font - د

 ندازه هر کدام در یک پنجره نمایش دهیم؟اگر بخواهیم چند فایل صفحه گسترده را با موقعیت و ا .80

 review از تب Protections انتخاب گزینه -الف 
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 review از تب Book Work Protect انتخاب گزینه -ب 

  window در قسمت window switch ها با استفاده از گزینهنمایش آن -ج 

 window در قسمت all arrange مرتب کردن آنها با استفاده از گزینه -د ✅

 .باشدیک عملگر ..... و * یک عملگر ...... می and عملگر .81

 ✅ منطقی و محاسباتی -الف 

 ایمنطقی و رشته -ب 

 ایآدرس و رشته -ج 

 محاسباتی و منطقی -د 

 باشد؟های صفحه گسترده باز شده کدام مینحوه مرتب کردن فایل .82

 ✅ view از تب Arrange انتخاب گزینه -الف 

 review از تب Arrang گزینهانتخاب  -ب 

 Icons Arrange انجام راست کلیک و انتخاب -ج 

 Icons Arrange انجام دوبار کلیک و انتخاب گزینه -د 

 شود؟برای آشکار یا پنهان کردن نوار آدرس و فرمول از کدام گزینه استفاده می .83

 review تب show از گروه bar formula - الف

 ✅ View تب show از گروه Bar Formula - ب

 data - از تب Formula - ج

 data و تب tools data از گروه Bar Formula - د

 کنیم؟برای وارد کردن فرمول در یک سلول از کدام فرمان استفاده می .84

 ✅ Formulas - Function - الف

 Insert - Function - ب

 Insert - Formulas - ج

 Formulas- Insert - د

 باشد؟ای میر از نوع دایرهکدام نمودار زی .85

 ✅ Pie - الف

 Area - ب

 Bundle - ج

 Cone - د

 شود؟ها از کدام گزینه استفاده میجهت ادغام سلول .86

 Wrap Text - الف

 Justify - ب

 ✅ Merg Cells - ج

 Shrink To Fit - د

استفاده باشد از کدام روش استفاده های باز نیز قابل های تعریف شده در یک فایل در بقیه فایل Style برای اینکه .87

 کنیم؟می

 کنیمکلیک می Add بر روی Style Cell - الف

 کنیمکلیک می Modify بر روی Style Cell از -ب 

 کنیمکلیک می Merge بر روی Style Cell از -ج ✅

 کنیمکلیک می Style بر روی Style Cell - د

 مفهوم ظاهر شدن علامت # در یک سلول چیست؟ .88

  .طول عدد نسبت به عرض سلول بزرگتر است -الف 

 .طول عدد علمی نسبت به عرض سلول بزرگتر است -ب ✅

 .سلول قالب بندی متنی شده دارد -ج 

 .سلول حاوی فرمول است -د 
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 انواع عملگرها در اکسل کدامند؟ .89

 ✅ ایمقایسه -ای رشته -محاسباتی  -عملگرهای منطقی  -الف 

 آدرس -محاسباتی  -عملگرهای منطقی  -ب 

 ایرشته -آدرس  -عملگرهای محاسباتی  -ج 

 ایرشته -آدرس  -ای مقایسه -عملگرهای محاسباتی  -د 

 طریقه نوشتن یک تابع در یک خانه چگونه است؟ .90

 MIN(A1;B5)= الف✅

  min= (A1,B5) ب

 min (X = A1 + B5) - ج

 min(C1=A1+B) - د

 توان استفاده نمود؟کدام کلید میبرای فعال کردن راهنمای برنامه از  .91

 ✅ 1F -الف 

 3F -ب 

 2F -ج 

 4F -د 

در هنگام درج خانه، برای اینکه خانه انتخاب شده به پایین حرکت کند و خانه جدید جای آن را بگیرد کدام مورد را  .92

 باید انتخاب نمود؟ Insert ایاز کادر محاوره

 Shift Cells Right - الف

 ✅ Shift Cells Down - ب

 Entire Row - ج

 Entire Column - د

 ها را تنظیم نمود؟توان خطوط کادر خانهمی Cell Format ایبا استفاده از کدام تب از کادر محاوره .93

 Alignment - الف

 Font - ب

 Number - ج

 ✅ Border - د

 دهد؟چه عملی انجام می Fill انتخاب Alignment و از تب Cells Format ایدر کادر محاوره .94

  .شود چنانچه طول متن از خانه بیشتر باشد بقیه متن در خط بعد قرار گیردباعث می -الف 

 .شود که متن نوشته شده در خانه طوری تغییر اندازه داده شود تا در طول خانه قرار گیردباعث می -ب 

 شوده میهای انتخاب شده در یک خانباعث ترکیب شدن محتوای خانه -ج 

 .شود تا عرض خانه را پر کندباعث تکرار متن می -د ✅

 چیست؟ IF عملکرد تابع .95

  .کندگذارد و اعداد جدید را جایگزین میهای انتخابی شرط میبر روی سلول -الف 

 .کندگذارد و اعداد جدید را جایگزین میها شرط میبر روی کلیه سلول -ب 

 .دهدگذارد، در صورت درست بودن شرط پیام مناسب میشرط میهای انتخابی بر روی سلول -ج ✅

 اک میکندگذارد و اگر شرط برقرار نباشد، محتوای سلول را پهای انتخابی شرط میبر روی سلول -د 

 های( صفحه کاری را تغییر داد چه باید کرد؟های )سلولرای اینکه نتوان محتوای خانه .96

  را انتخاب نماییم Locked را فعال کرده و گزینه Protection تب Cells Format ایاز کادرمحاوره -الف 

کنیم و را کلیک می Sheet Protect گزینه Review کنیم و سپس از سربرگمی locked ابتدا سلول را -ب ✅

 .دهیمکلمه رمز قرار می

 .کنیمرا کلیک می Workbook Protect را کلیک کرده و سپس Protection گزینه Tools از سربرگ -ج 

کنیم و را کلیک می Workbook Protect گزینه Review کنیم و سپس از سربرگمی locked ابتدا سلول را -د 

 .دهیمکلمه رمز قرار می

 رود؟ها به کار میهای عددی یک محدوده از خانهکدام تابع برای محاسبه میانگین داده .97

 Sum - الف



بشارت آموزشگاه کامپیوتر، حسابداری، نقشه کشی، هوش مصنوعی و ارز دیجیتال  

65265563-021  

65265564-021 116پلاک  -کوچه شقایق -جنب بانک ملی -بلوار رسول اکرم -شهریار     
 

 Count - ب

 ✅ Average - ج

 Round - د

  SUM(ALI;B2;C3)=  باشد حاصل تابع زیر کدام است؟ =1A ،1B =ALI ،61C=5های اگر خانه .98

  5 -الف 

 11 -ب 

 Ali 5 6 -ج 

 Name خطای -د ✅

 باشد. حاصل تابع زیر کدام است؟2C  =ALIوA1= True ،  B2= Falseاگر مقادیر خانه .99

 Count(A1; B2; C2) = 

  2 -الف 

 0 -ب ✅

 1 -ج 

 3 -د 

 IF(A1=Kh,"t","f")= باشد حاصل تابع زیر کدام است؟ B1=KH،F3=4 ,A1=TRUE اگر .100

 4 -الف 

 ✅ f - ب

 Error - ج

 3F -د 

 دهد؟کدام گزینه قالب بندی شرطی را انجام می .101

 style formatting - الف

 ✅ conditional formatting - ب

 formatting - ج

 Auto Filter - د

 کند؟طراحی گزارش، میانگین اعداد را محاسبه می کدام یک از توابع زیر در .102

 Count - الف

 Sum - ب

 ✅ Average - ج

 Maximum - د

 کند؟ها را شمارش میکدام تابع اعداد موجود در یک ناحیه از سلول .103

 ROUND - الف

 ✅ COUNT - ب

 COUNTA - ج

 LEN - د

 است؟کدام  4Aدر  SUM(A1;A3) حاصل فرمول=3A،20 =A2،10 A1=30با فرض  .104

  50 -الف 

 60 -ب 

 40 -ج ✅

 30 -د 

 شود که متن نوشته شده در سلول در صورت طولانی شدن در چند سطر قرار گیرد؟چه چیز باعث می .105

 STRIKE - الف

 MERGE CELLS - ب

 SHRINK TO FIT - ج

 ✅ WRAP TEXT - د
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 دهد که پهنای سلول قابلیت نمایش محتویات آن را ندارد؟کدام خطا نشان می .106

 #VALUE - الف

 #DIV - ب

 ✅ ##### - ج

 #NAME - د

باعث اعمال فرمت با قالب رایج پول  CELLS FORMAT های زیر واقع در پنجرهکدام یک از گزینه .107

 شود؟می

 SPECIAL - الف

 ✅ CURRENCY - ب

 TEXT - ج

 FRACTION - د

 رود؟کدام تابع برای محاسبه مجموع چند عدد به کار می .108

 ✅ SUM - الف

 COUNT - ب

 AVERAGE - ج

 COUNTIF - د

 شود؟دهی مطلق از چه علامتی استفاده میجهت آدرس .109

 ؟ -الف 

 ✅ $ - ب

 # - ج

 & - د

 چه کاربردی دارد؟ cells format در پنجره fill سربرگ .110

 پر کردن یک خانه با واژه مورد نظر -الف 

 ✅ تغییر رنگ زمینه سلول -ب 

 سازی داخل سلولفشرده -ج 

 ترازبندی اطلاعات داخل سلول -د 

 ی زیر برای نمایش قالب متنی کاربرد دارد؟کدام نوع داده .111

 CURRENCY - الف

 NUMBER - ب

 ✅ TEXT - ج

 GENERAL - د

 میانبر ساخت نمودار کدام است؟ .112

 1F -الف 

  2F -ب 

 10F -ج 

 11F -د ✅

113. CHART چیست؟ 

 .یک تابع است -الف 

 ✅ .شودها و اطلاعات موجود استفاده میارقام، دادهنموداری است که برای مقایسه  -ب 

 .یک نمودار سازمانی است -ج 

 .شودبرای درج تصاویر گرافیکی استفاده می -د 

 (D=2^3*2+4/2)نتیجه حاصل از فرمول روبرو در اکسل چه عددی است؟  .114

 144 -الف 

 66 -ب 

  10 -ج 
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 18  -د️✔

 باشد؟ EXCEL های کاربرگاز خانه تواند نام یک خانهکدام یک از موارد زیر می .115

 2AZ-الف

 ZA - ب

 2A1 –ج 

 1A -د ️✔

 کدام است؟ 6Kآدرس مطلق سلول  .116

 $ 6K$ -الف 

 K$6$ –ب ✅

 $6K -ج 

 K$6 -د 

 .نامندهر واحد نگهداری اطلاعات در اکسل را یک ........................ می .117

 ✅ سلول -الف 

 ROW - ب

 COLUMN - ج

 Line - د

 .باشدصفحه کاری ................................ مینام دیگر  .118

 Cell - الف

 workbook - ب

 ✅ Worksheet - ج

 sheet - د

 باشد؟کدام نوار ویژه محیط اکسل می .119

  Ribbon - الف

 Formul Bar - ب✅

 AddressBar - ج

 Quikaccess - د

 شود؟ها با کدامیک از موارد زیر مشخص میعناوین سطرها و ستون .120

 ها با حروف الفباسطرها و ستون -الف 

 ها با ارقامسطرها و ستون -ب 

 سطرها با حروف الفبا و ستون با اعداد -ج 

 ✅ ها با حروف الفبای الفتین و سطرها با اعدادستون -د 

 کنیم؟از کدام فرمان برای ایجاد یک فایل صفحه گسترده جدید استفاده می .121

 Format - الف

 Copy - ب

 ✅ New - ج

 Cut - د

 شود؟ها از کدام گزینه استفاده میبرای مرتب کردن داده .122

  Auto Fill - الف

 Sort - ب✅

 auto - ج

 Comments - د

 شود؟جهت تایید و لغو محتویات یک سلول از کدام گزینه استفاده می .123

 ✅ .جهت لغو محتویات سلول Esc جهت تایید و دکمه Enter دکمه -الف 

 جهت لغو محتویات سلول Esc جهت تایید و دکمه backspace دکمه -ب 



بشارت آموزشگاه کامپیوتر، حسابداری، نقشه کشی، هوش مصنوعی و ارز دیجیتال  

65265563-021  

65265564-021 116پلاک  -کوچه شقایق -جنب بانک ملی -بلوار رسول اکرم -شهریار     
 

 جهت لغو محتویات سلول Spacebar جهت تایید و دکمه Tab دکمه -ج 

 جهت لغو محتویات سلول Spacebar جهت تایید و دکمه Enter دکمه -د 

 دهد؟چه عملی انجام می painter format ابزار .124

 کندقالب متن را حذف می -الف 

 ✅ .کندمیقالب متن را کپی  -ب 

 کندمتن را کپی می -ج 

 کندمتن را قالب بندی می -د 

 .کنیم، از کلید .................. استفاده میExcel های غیرمجاور دربرای انتخاب خانه .125

 Insert - الف

 Alt - ب

 ✅ Ctrl - ج

 Shift - د

 دهیم؟چه کاری انجام می Copy or Move در پنجره copy a Create با گزینه .126

 درج کاربرگ جدید -الف 

 حذف کاربرگ -ب 

 ✅ ایجاد یک کپی از کاربرگ -ج 

 جابجایی کاربرگ -د 

 کنیم؟از کدام گزینه جهت افزودن اعشار استفاده می .127

 Style - الف

  Decrease Decimal - ب

 Decimal - ج

 Increase Decimal - د✅

 کنیم؟ها از کدام فرمان استفاده میبرای ادغام خانه .128

 Condition Format - الف

 ✅ Merge & Center - ب

 Format Painter - ج

 Comment - د

 شود؟جهت شکستن متن اضافی در یک سلول از کدام گزینه استفاده می .129

 Split Cell - الف

 Shrink to Fit - ب

 ✅ Wrap Text - ج

 Merge & Center - د

های قبل از سلول انتخابی از کدام و ستون، برای ثابت شدن سطرها Freeze در زمان استفاده از فرمان .130

 نماییم؟گزینه استفاده می

 Freeze First Column - الف

 Freeze Top Row - ب

 ✅ Freeze Panes - ج

 Freeze All Column - د

، برای ثابت شدن اولین سطر از گزینه ....................... استفاده Freeze در زمان استفاده از فرمان .131

 .نماییممی

 Freeze First Column - الف

 ✅ Freeze Top Row - ب

 Freeze Panes - ج

 Freeze All Column - د
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 گردد؟چه زمانی مشاهده می #0DIVخطای / .132

 باشدتواند محتویات سلول را به فرم صحیح نمایش دهد زیرا پهنای ستون مناسب نمیزمانی که اکسل نمی -الف 

 باشدیپهنای ستون مناسب نم -ب 

 ✅ .ها بر صفر تقسیم شده استزمانی که یکی از داده -ج 

 ها را در فرمول شناسایی نمایدتواند یکی از دادهزمانی که اکسل نمی -د 

 دهنده آدرس نسبی است؟کدامیک نشان .133

 $1C$ -الف 

 $1C -ب 

  1C$ -ج 

 1C -د ✅

 توان مشاهده نمود؟جدا کننده صفحات را در کدام نما می .134

 ✅ Page Layout - الف

  Page Break Preview - ب

 Normal - ج

 Custom View - د

 شود؟به نمودار ستونی چه گفته می .135

 Line - الف

 Pie - ب

 Area - ج

 ✅ Column - د

 شود؟کدام فرمان برای اجرای مکرر دستورات استفاده می .136

  Auto fill - الف

 Auto Filter - ب

 ✅ Macro - ج

 Comments - د

 نماییم؟محافظت کاربرگ ابتدا راست کلیک سپس کدام فرمان را انتخاب میجهت  .137

 Move - الف

 ✅ Protect Sheet - ب

 Cut - ج

 Copy - د

 .کنیمها از تابع ............... استفاده میهای خانهجهت تعریف شرط بر روی داده .138

 Average - الف

 Round - ب

 ✅ If - ج

 Sum - د

 .شود.............. یک ناحیه استفاده میجهت  count از تابع .139

 گرد نمودن اعداد -الف 

 ✅ شمارش تعداد اعداد -ب 

 میانگین اعداد -ج 

 جمع اعداد -د 

 رود؟ها به کار میکدام تابع برای عمل جمع سلول .140

 Max - الف

 Average - ب

 Min - ج

 ✅ Sum - د
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 14=1A(IF(,”No”;”Ok“) باشد نتیجه فرمول زیر چیست؟ 1A=14اگر  .141

 ✅ Ok - الف

 No - ب

 True - ج

 False - د

 گردد؟های همجوار و درج در تابع از کدام علامت استفاده میبرای انتخاب سلول .142

 ✅ : - الف

 ; - ب

 , - ج

 $ - د

خواهید بدون استفاده از ماوس به خانه اید و میقرار گرفته 2Fفرض کنید روی خانه  2019در اکسل  .143

1A  دهد؟این کار را انجام میبروید، کدام مورد 

 Tab - الف

 Ctrl+A1 - ب

 ✅ Ctrl+Home - ج

 shift+tab - د

اگر بخواهیم یک کاربرگ در موقع چاپ در اندازه واقعی کاربرگ چاپ شود از کدام ابزار استفاده  .144

 شود؟می

 Scale - الف✅

 View > Custom View - ب

  View > Zoom to selection - ج

 Size - د

 کدام فرمول مناسب است؟A1+A2+A3+B4+B5+B6+7برای محاسبه عبارت  .145

  SUM(A1:A3:B4:B6:7) - الف

 - SUM(A1:B6+7) - ب

   SUM(A1+A3:B4+B6+7) - ج

   SUM(A1:A3+B4:B6+7) - د️✔

 گیرد؟در کدام مورد قرار می 2019های یک تابع در محیط اکسل ورودی .146

 ✅ ) ( - الف

 ’ ’ - ب

 " " - ج

 >< - د

کپی کنید نتیجه  2Aاید. اگر این سلول را در را درج کرده 6D4+Bفرمول  1Aفرض کنید در سلول  .147

 کدام خواهد بود؟

  B5+D7 - الف

 #REF! - ب

 C4+E6 - ج

 B6+D4 – د✅

 درج کدامیک از علائم زیر در هنگام نوشتن فرمول در سلول الزامی است؟ .148

 استوابسته به توابع استفاده شده در فرمول  -الف 

 ✅ مساوی -ب 

 جمع -ج 

 پرانتز -د 

 کدام است؟ Excel 2019در محیط  Area Print کاربرد ابزار .149

 های موجود در یک کاربرگچاپ نمودار ایجاد شده از داده -الف 
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 Excel پیش نمایش صفحه به صفحه یک کاربرگ از یک فایل -ب 

 ✅ انتخاب یک محدوده مشخصی از کاربرگ برای پرینت گرفتن -ج 

 تعیین بزرگترین محدوده ممکن جهت چاپ -د 

 شود؟ظاهر می #NAME? در کدام یک از موارد زیر خطای .150

=SUM(A2:A5) - الف 

=SUM(A2,A5) - ب 

=SUM(A2) -ج 

=SUM(A2A5) - د ✅ 

، اولین سطر کاربرگ در تمام صفحات تکرار شود از کدام Excel اگر بخواهید به هنگام چاپ یک فایل .151

 گیرید؟میابزار کمک 

Page Layout > Print Titles - الف ✅ 

Home > Cells > Format - ب 

Data > Text to Columns - ج 

Home > Wrap Text - د 

 

 

 


